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SplashBuddy is created to provide an elegant and secure onboarding experience for Mac users during 
automated enrollment process. SplashBuddy notifies the user when it detects that certain software 
has been installed. You must specify which log file SplashBuddy monitors for software that’s been 
installed (there are two possible log files). SplashBuddy notifies the user only about software packages 
that you specify. When SplashBuddy recognizes a package name in the log file, it notifies the user that 
the package is being installed. This guide shows you how to modify SplashBuddy for the appropriate 
log file and package names, as well how to configure a few other SplashBuddy settings.

Special thanks to the following people for all their effort in SplashBuddy Project:
Francois Tiffreau, Yoann Gini, Damien Rivet

SplashBuddy allows you to:
• Prevent users from using their Mac before software that you require is installed
• Provide status about the software that is currently being installed
• Display onboarding information

This guide was created using the following:
• Jamf Cloud 10.20.1
• macOS Catalina 10.15.4
• SplashBuddy 2.0.0  

https://github.com/davidyoondrums/SplashBuddy/releases/
• Composer 10.20.1

Requirements
• Apple Business Manager/Apple School Manager
• A Mac assigned to your mobile device management (MDM) solution in Apple Business 

Manager/Apple School Manager
• A package creation app of your choice (this guide uses Composer from Jamf)
• An MDM solution which supports the ability to install one or more signed packages before 

Setup Assistant has completed (ideally using InstallEnterpriseApplication MDM command)
• Optional: A Mac with two apps installed, to gather the icon for each app (this guide uses 

Google Chrome and Slack as examples).
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Section 1: Gather a Signed Certificate
In order for your MDM solution to successfully use the InstallEnterpriseApp MDM command to install 
a package, the package must be signed with a TLS certificate. In order to sign the package, you need 
a certificate. One option is to use a certificate signed by your Jamf Pro instance’s Certificate Authority. 
Another option is to use your Apple Developer ID. This guide covers both options.
 

Option A: Create a certificate that only Mac computers enrolled with your Jamf Pro will trust  
1. Open Keychain Access.

2. Go to the Keychain Access menu, choose Certificate Assistant, then choose Request a Certificate 
From a Certificate Authority.

3. In the Certificate Information window, in the User Email Address field, enter an organizational  
email address.

4. In the Common Name field, enter your organization’s name.

5. Select “Saved to disk”.

6. Click Continue.

7. In the Save As dialog, optionally change the destination (this guide uses Desktop as an example) 
then click Save.
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8. Click Done. A private key is automatically generated and saved in your login keychain.

9. Open the file you just created. In the Finder, Control-click the file, then choose Open With, then 
choose a Text Editor. If TextEdit doesn't appear in the menu, choose Other, then select TextEdit 
in the Applications folder, then click Open. Usually when you edit script files, you should avoid 
TextEdit, but it’s fine to use TextEdit to copy the contents of the Certificate Signing Request.

10. In TextEdit, press Command-A to select all the text in the file.
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14. Click Management Certificate Template.

15. Click Create Certificate from CSR.

16. Click inside the CSR field, then press Command-V to paste the contents of the Clipboard (which is 
the text of the Certificate Signing Request).

11. Press Command-C to copy the text.

12. With a web browser, log in to your Jamf Pro.

13. Navigate to Settings > Global Management > PKI Certificates

14

15

Paste the 
contents of the 
Clipboard into 
this field
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17. Click the menu for Certificate Type then choose Web Server Certificate.

18. Click Create.

19. Your browser automatically downloads a newly-signed certificate to the browser’s default location; 
for this guide, the default location is your Downloads folder. Your browser might display a wait 
status indicator indefinitely. After the certificate is downloaded, you can safely close the browser 
window or navigate to a different page.



8

How to Deploy SplashBuddy as a PreStage Enrollment Package in Jamf Pro

21. Open the pem file.

22. If you’re prompted to add the certificate to a keychain, click the Keychain menu and choose 
"login," then click Add. Note: Keychain Access might automatically add the certificate to your login 
keychain.

23. In Keychain Access, in the lower-left corner, click My Certificates. 

24. To confirm that the certificate you just imported is displayed with the private key, select the 
certificate and click the disclosure triangle. Note: At this point your Mac is the only place where 
your private key for this certificate is stored.

20. In the Finder, navigate to the folder that contains the newly-signed certificate. In the following 
example, the file is in the Downloads folder, its name reflects the organization’s name, and it has 
the “.pem” suffix (although pem historically stands for Privacy-enhanced Electronic Mail, you won’t 
be using this certificate for mail).
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25. If your Mac that you used to create the Certificate Signing Request (CSR) is enrolled in your Jamf 
Pro, your Mac trusts the Jamf Pro Certificate Authority (CA), which signed your CSR, so that Mac 
trusts the new certificate. If your Mac is not enrolled with your Jamf Pro, you need to configure 
your Mac to trust the certificate so that your package creation tool (this guide uses Composer) can 
use the certificate. To do this:

A. Double-click the certificate you just imported.

B. Click the disclosure triangle next to Trust, click the menu next to “When using this 
certificate” and choose “Always Trust.”

C. Choose File > Close to close the certificate window, then at the “You are making changes 
to your Certificate Trust Settings” dialog, provide your credentials to allow the update.

D. Confirm that the certificate is displayed with “This certificate is marked as trusted for this 
account.”

26. Optionally, export the certificate with your private key so you have a backup of it, and so that you 
can import it on another Mac. With the certificate selected, Choose File > Export Items.
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27. In the Save As field, enter a name like JamfProSignedCert.
A. Enter a location to save; this guide uses Documents.
B. Leave the File Format as Personal Information Exchange (.p12) because this format includes 

the private key.
C. Click Save.

28. Enter a password to secure the certificate, enter it again to verify, then click OK. You can click 
the key icon to open the Password Assistant to help generate a secure password. If you use an 
organizational password vault system, record this password.

29. In the dialog, enter your login password then click Allow.

30. Copy the exported certificate to secure location, backup media, organization shared folder, or 
another Mac.

31. Quit Keychain Access.

A

B

C
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Option B: Use your Developer ID Installer certificate
Download your Developer ID Installer certificate and install it on your Mac. If required, follow this step:

https://support.jamfnow.com/s/article/000002601-Tutorial-Building-and-Signing-Mac-Packages 

(Complete up to "Generating a Certificate" section)



12

How to Deploy SplashBuddy as a PreStage Enrollment Package in Jamf Pro

Section 2: Use Composer to create a signed SplashBuddy
1. Open Composer.

2. If necessary, enter your login password.

3. If you are prompted to allow Composer full disk access, take the following steps:

A. Select the checkbox “Don’t display this message again.”
B. Click System Preferences.
C. Confirm that System Preferences opens to the Privacy pane of Security & Privacy preferences.
D. In the lower-left corner, click the lock, then provide administrator credentials.
E. In the left column, select Full Disk Access.
F. In the list of apps, click Add (+).
G. Select the Composer app then click Open.
H. At the message, “Composer will not have fill disk access until it is quit,” click Later.
I. Quit System Preferences.
J. In the list of apps, confirm that the checkbox is selected for Composer.

4. If Composer displays the Snapshot dialog, click Cancel.
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5. From the Composer menu at the top of the screen, choose Preferences.

6. Select the checkbox for “Sign with”.

7. Click the menu and choose an appropriate certificate.

    For the certificate signed by Jamf Pro, it will have your organization’s name:

    For your Developer ID Installer, it will start with “Developer ID Installer.”

8. Click Save.

9. Close the Preferences window.

10. Quit Composer.
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Section 3: Customize onboarding information screen shown in SplashBuddy
By default, when SpashBuddy opens, it displays generic information. It is recommended that you 
customize the two sections of the SplashBuddy window so that the user knows what apps are 
getting installed during the enrollment process. You also have the ability to customize the onboarding 
information screen with information about your organization, the Mac they are receiving, and any other 
information you desire.

In this section you'll customize the onboarding information section of the SplashBuddy screen. For this 
part of the guide, you will use a code editor; it’s not recommended to use TextEdit, because it can add 
unwanted formatting and characters. This guide uses BBEdit as an example, which is available from 
the Mac App Store or from here: https://www.barebones.com/products/bbedit/.

Version 2 of SplashBuddy builds on earlier versions and includes the ability to parse information from /
private/var/install.log.

1. Download the SplashBuddy zip file from:  
https://github.com/davidyoondrums/SplashBuddy/releases/ 

2. In the Finder, if the zip file wasn’t automatically unarchived, then double-click the SplashBuddy zip 
file to unarchive the file. 

3. Drag the SplashBuddy folder to your desktop.  

4. Open the SplashBuddy 2.0.0 folder.

5. Navigate to the SplashBuddy 2.0.0/payload/Library/Application Support/SplashBuddy folder.
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6. Control-click the presentation.bundle file, then choose Show Package Contents.

7. In the window that appears, open the en.lproj folder. There are two files to take note of. index.html is the 
file that SplashBuddy uses to display the onboarding information of your choice, and the img folder is 
where you save any image(s) referenced in the index.html file.

8. Obtain your company logo in a png format file, then place it in the img folder. 

9. Open the index.html file in a web browser of your choice. Confirm that the web browser displays 
onboarding information. This index.html template contains 5 example screens which rotate every 25 
seconds. You are able to change these screens to those of your choosing.
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10. Close the browser window that is displaying the index.html file. 

11. In the Finder, control-click the index.html file, choose Open With, then choose the code editor of 
your choice. This guide uses BBEdit as the text editor. 
 
 
 
 
 
 
 
 
 
 

12. Confirm that the text editor you chose opens the index.html file. Review the html code used in 
index.html.  



17

How to Deploy SplashBuddy as a PreStage Enrollment Package in Jamf Pro

13. Locate the first html code block in the index.html file. This code corresponds to the following 
onboarding information screen:

<div class="section" id="section1" style="background-image: var(--background-image)">
<h1 class="animated fadeInUp">Welcome to<span class="accentBlue"> Pretendco</span></h1>
<br>
<img src="img/PretendcoNeon.png" height="150" class="animated fadeInUp" /> 

</div>

15
14

Original page

New page after HTML edits

14. Change "Pretendco" to your company name.

15. Change "img/PretendcoNeon.png" to "img/YourCompanyLogo.png". 

16. Save the index.html file. 

17. Refresh the browser to to confirm your edits. 
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18. Locate the second html code block in the index.html file. This code corresponds to the following 
onboarding information screen in a web browser. As examples, you'll change the color of the type 
and the size of the MacBook Pro.

19. Make the following changes in the index.html file: 
a. Replace "Installing" with "Please be patient". 
b. Add "Installing" at the end of Company Apps so it reads "Company Apps Installing". 
c. Change the value of height from 420 to 200 

20. Save the index.html file. 

21. Refresh the browser to confirm the changes are displayed the second page. To display the 
second page immediately, you can click the second dot on the right-side of the image.

<div class="section" id="section2" style="background-image: var(--background-image)">
<h1>Installing <span class="accentYellow">Company Apps</span></h1>
<p>Once all apps are installed, click continue.</p>
<img src="img/macbook.png" height="420" class="animated fadeInUp"/> 

</div>

Original page

New page after HTML edits



19

How to Deploy SplashBuddy as a PreStage Enrollment Package in Jamf Pro

22. Locate the third html code block in the index.html file. This code corresponds to the following 
onboarding information screen in a web browser. 

<div class="section" id="section3" style="background-image: var(--background-image)">
<h1>Self <span class="accentPink">Service</span></h1>
<br>
<h2>Self Service is your company approved portal for software installation and updates! 
Be sure to check in often to keep your Mac healthy and secure</h2>
<br>
<img src="img/selfservice.png" height="200" />

</div>

Original page

New page after HTML edits

23. You'll delete the text under the title. 

24. Delete the line, <h2> Self Service is ... healthy and secure<h2>. 

25. Save the index.html file. 

26. Refresh the browser to confirm the changes are displayed on the third page. 
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27. Locate the fourth html code block in the index.html file. This code corresponds to the following 
onboarding information screen in a web browser. 

28. Delete the entire code block above. This reduces the number of onboarding information screen 
from 5 to 4. The screen will be deleted out of the rotation.

29. Save the index.html file. 

30. Refresh the browser to confirm the changes are displayed the third page.

<div class="section" id="section4" style="background-image: var(--background-image)">
<h1>Not in the  <span class="accentTeal">Office</span></h1>
<br>
<h2>Install the VPN client from Self Service.<h2>
<br>
<img src="img/vpn.png" height="200" />
<br>
<h2>You are now ready to connect to the company network! <h2>

</div>

Optional: More customization for the Onboarding pages.
Light mode/Dark Mode
If you change the background image, then you need to provide the light version and the dark version. 
Make sure to name your images “background-dark.jpeg” for the dark version and “background-light.
jpeg” for the light version. Place both files in the “img” folder.

The result is that when a user chooses Dark Mode during Setup Assistant, SplashBuddy uses 
background-dark.jpeg for the background. Similarly, if the user chooses Light Mode during Setup 
Assistant, then SplashBuddy uses background-light.jpeg for the background.

Note: Although you are longer using the PretendcoNeon.png file in your index.html file, this guide uses 
PretendcoNeon.png for this example.
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Page Scrolling  
You can change the value of “scrollingSpeed:” to change how fast the screen scrolls between pages. 
By default it's set to 700 which is 0.7 seconds.

You can change the value of “fn.fullpage.moveSectionDown()” to change how long it will take for the 
next page to auto scroll. By default it’s set to 25000 which is 25 seconds.

Once you made final changes to the index.html, save the document. Also make sure that any images 
you have included in each screen are in the “img” folder with the appropriate name defined in the 
index.html file. Refresh your browser and confirm your changes. 

<script type="text/javascript">
$(document).ready(function() {

$('#fullpage').fullpage({
css3: true,
navigation: true,

navigationPosition: 'right',
scrollingSpeed: 700,
loopBottom: true,
keyboardScrolling: true,

<!-- JavaScript Function to move down sections in millisecond intervals -->
afterRender: function(){
 setInterval(function(){
  $.fn.fullpage.moveSectionDown()
 }, 25000);
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Section 4: Gather app icons used in SplashBuddy
In order for SplashBuddy to display an app icon for each app that it installs, you need to gather  
each app icon. Use this section to gather app icons. There are at least two ways to gather an app's 
icon. One option is to use an app that creates an icon, and another option is to use the Get Info 
window for an app. This guide covers both options. In a pinch, you could just use an internet search 
for an app's icon. 

Option A: Use Self Service Icon Maker to gather all required icons

1. In a web browser, go to: https://github.com/mm2270/Self-Service-Icon-Maker.

2. Click Self Service Icon Maker.app.zip.

3. Click Download.

4. In the Finder, open your Downloads folder. 

5. If your browser didn't automatically unarchive Self Service Icon Maker, then in the Finder, double-click Self 
Service Icon Maker.app.zip. 

6. Drag the Self Service Icon Maker app from your Downloads folder to your Applications folder.
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7. In your Applications folder, Control-click Self Service Icon Maker and choose Open.

9. If there's a notification in the upper-right corner that asks for permission for Self Service Icon Maker 
to send you notifications, click Allow.

10. In the dialog "Choose a folder for where icons should be saved. If you Cancel, they'll be saved to 
your Desktop." click Cancel. 

11. Drag an app to the main window of Self Service Icon Maker. This guide uses Slack as an example.

12. In the Finder, confirm that Self Service Icon Maker successfully saved a new image file and saved it 
on your Desktop.

13. Repeat steps 11 and 12 for each additional app icon you want SplashBuddy to display. This guide 
uses Google Chrome as the other app example. 

14. Drag all the app icons into the folder SplashBuddy 2.0.0/payload/Library/Application Support/
SpashBuddy/.

15. Quit Self Service Icon Maker.

8. In the dialog that macOS cannot verify the developer of “Self Service Icon Maker,” click Open. 
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3. In the upper-left corner of the Info window, select the app icon.

4. Press Command-C to copy the icon to your Clipboard.

Option B: Use the Get Info window for an app to gather its icon

An alternative to Self Service Icon Maker is to use the Get Info window for an app to copy its icon, 
then use Preview to export an file in png format. 

1. Open the Applications folder.

2. Control-click an app and choose Get Info.

5. Open the Preview app.

6. Click Cancel.
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7. Click the File menu then choose “New from Clipboard”.

8. In the sidebar, select the first image.

9. Choose File > Export.
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10. In the Export As field, enter a name that indicates the name of the app.

11. Below the Tags field, click the menu and choose a location to save the file. This guide uses 
Desktop as an example.

12. Click the Format menu then choose PNG.

13. Click Save.

14. Repeat steps 2-13 for each app icon  that you want SplashBuddy to display. 

15. Drag all the app icons into the folder SplashBuddy 2.0.0/payload/Library/Application Support/
SpashBuddy/.

10

11

12

13
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Section 5: Gather “packageName” for app installer package
To ensure that SplashBuddy is able to interpret the logs to display each app as it is being displayed, 
you need to determine what is being recorded in /private/var/log/install.log as the app is installed after 
enrollment. This guide uses Google Chrome as an example.

1. In a web browser, visit https://cloud.google.com/chrome-enterprise/browser/download.

2. Next to "Chrome PKG for Mac," click Download.

3. Click Download. 

4. Throughout this guide, if your browser asks permission to download files from a site you visited, click 
Allow.

5. Download the “Install Log Name” app from here: https://hcsonline.com/support/apps/install-log-app

6. In the Finder, double-click Install_LogName.zip to unarchive it.

7. Drag the “Install Log Name” app to the /Applications folder.

8. In the Applications folder, Control-click the Install Log Name app then choose Open.

9. Click Open.
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11. Drag the GoogleChrome.pkg into the main window of the Install Log Name app. 

12. Take note of the result(s), in this case “Google Chrome”. You’ll need this string to customize the 
app install indicator.

10. In the upper-right corner, in the notification that asks for permission for Install Log Name to send 
notifications, click Allow.
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Section 6: Set policy to install application upon enrollment complete

1. Upload the GoogleChrome.pkg to Jamf Pro in “Settings”. If required, follow this step:  
https://docs.jamf.com/10.21.0/jamf-pro/administrator-guide/Managing_Packages.html

2. Create the policy to push “GoogleChrome.pkg”. If required, follow this step:  
https://docs.jamf.com/10.21.0/jamf-pro/administrator-guide/Managing_Policies.html.

3. Set the trigger as “Enrollment Complete”. Also, scope to the computer that you want to  
use for testing. 
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Section 7: Customize app install indicator
1. In the Finder, navigate to the Desktop folder, then navigate to  

/SplashBuddy 2.0.0/payload/Library/Preferences/.

2. Control-click io.fti.SplashBuddy.plist, choose Open With, then choose your code editor (this guide 
uses BBEdit as an example).

3. Confirm that your text editor displays the content of the plist file.

4. Locate the continueAction key. 
<key>continueAction</key> 
<string>Quit</string>

5. Decide which value to assign for the key. You can use any of the following options (this guide uses 
the default value, Quit, as an example):

a. Quit: quit SplashBuddy
b. Restart:  restart computer
c. Logout: log out of the computer
d. Hidden: hide the button
e. Shutdown: shut down the computer
f. Applications/Self Services.app: launch app by setting a path
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6. Leave the value of InstallerInsider as <true/>. With this setting SplashBuddy reads from  
macOS /private/var/log/install.log to determine what apps are getting installed. For the purpose  
of this guide, keep this setting as is. 
<key>InstallerInsider</key> 
<true/> 
Optional: Set the value for InstallerInsider to <false/>, and set the value for JAMFInsider to <true/>. 
With this setting, SplashBuddy reads from /private/var/log/jamf.log.

7. Leave the value for fullScreen as <true/>, so SplashBuddy runs in full screen. The user will not be able 
to do anything else with their Mac until SplashBuddy quits. 
<key>fullScreen</key> 
<true/>

8. Set the value of canContinue to <false/>. With this setting, a button to exit out of SplashBuddy will not 
appear until the app install indicator in question turns green. 
<key>canContinue</key> 
<false/>

9. Set displayName to “Internet Browser”. You can define what kind of app is getting installed. Eg: 
“Internet Browser”, “Collaboration Tool”, etc. 
<key>displayName</key> 
<string>Internet Browser</string>

10. Set description to “Installing Chrome”. Put the description of what is getting installed. Eg: “Installing 
Google Chrome” 
<key>description</key> 
<string>Installing Chrome</string>

11. Set iconRelativePath to “Chrome.png”. Set the name of the png file that you saved to /img folder 
inside the presentation.bundle. For example, “chrome.png” for the Google Chrome icon and  
“slack.png” for the Slack icon. 
<key>iconRelativePath</key> 
<string>chrome.png</string>

12. Set packageName to “Google Chrome”. Use the string that you saved from section 5 of this guide 
where you used the Install Log Name app to get the packageName. Since SplashBuddy ignores the 
version numbers of the installer package, you do not need to include it in the packageName. 
<key>packageName</key> 
<array> 
<string>GoogleChrome</string> 
</array>

Option: Sometimes you will get more than one packageName during Section 5. Then include all of 
them as part of an array so that SplashBuddy can successfully detect the packageName. Take a look 
at the following example. 

13. If you choose to install Slack via Apps and Books in Jamf, then leave out the section below. 
Otherwise delete the entire section shown below.  
<key>packageName</key>
<array>
<string>GoogleChrome</string>
<string>Google Chrome</string>
<string>com.google.Chrome</string> 

</array>

14. For each additional app installation indicator you want SplashBuddy to display, insert a new block of 
code for the app. Copy and paste the code block above, then modify keys as needed.

15. Save the io.fti.SplashBuddy.plist file.

16. Quit your text editor.
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Section 8: Use Composer to create and sign the SplashBuddy Installer Package

Although the SplashBuddy 2.0.0 folder includes the script build_pkg.sh to create a SplashBuddy Installer 
package without code signing, you need to create and sign the SplashBuddy Installer package in order to use 
it as a Jamf Pro Computer PreStage Enrollment package.  

1. Open Composer. 

2. If you see the “Composer required full disk access” message, and you’ve already granted it in section X, 
then select the checkbox for the “Don’t display this message again” option, then click OK.

4. In the Finder, open the SplashBuddy 2.0.0 folder.

5. Drag the payload folder to the Sources section in Composer.

3. If Composer displays the Snapshot dialog, click Cancel. 
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7. In the Sources section, click the disclosure triangle next to “payload”.

8. Control-click the Scripts folder, choose Add Shell Script, then choose postinstall. 

9. Select entire block of code below, then press Command C to copy the script to the Clipboard.

#!/bin/bash

loggedInUser=`python -c 'from SystemConfiguration import SCDynamicStoreCopyConsoleUser; 
import sys; username = (SCDynamicStoreCopyConsoleUser(None, None, None) or [None])
[0]; username = [username,""][username in [u"loginwindow", None, u""]]; sys.stdout.
write(username + "\n");'`

loggedInUID=`id -u ${loggedInUser}`

if [[ ${loggedInUID} -gt 500 ]]; then

 echo "Launching SplashBuddy for user ${loggedInUID}…"

 sudo -u \#${loggedInUID} launchctl enable gui/${loggedInUID}/io.fti.SplashBuddy.launch

 sudo -u \#${loggedInUID} launchctl bootstrap gui/${loggedInUID}/ /Library/LaunchAgents/
io.fti.SplashBuddy.launch.plist

 sudo -u \#${loggedInUID} launchctl kickstart gui/${loggedInUID}/io.fti.SplashBuddy.
launch

fi

The postinstall script is now created, and it’s ready to be modified.

6. If a file named .DS_Store is present, then Control-click .DS_Store, choose Delete .DS_Store, then 
click Delete to confirm.



34

How to Deploy SplashBuddy as a PreStage Enrollment Package in Jamf Pro

10. In Composer, in the postinstall script, press Command-A to select all the text in the postinstall 
script.

11. Press Command-V to paste the script from the Clipboard into the postinstall script.

12. Press Command-S or choose File > Save to save the changes.

13. Control-click payload then choose “Rename payload."

14. Enter the name SplashBuddyInstaller.
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15. In the Library folder, all folders except SplashBuddy.app and presentation.bundle. The following 
figure displays all the components that are required to be in the SplashBuddy installer package. 

16. Click the Library folder. 

17. Click the Owner menu and choose “root (0).”

18. Click the Group menu and choose “wheel (0).” 

19. Confirm that the permissions are set to the exact settings displayed in the following figure.

20. Click the Action menu (looks like a gear) and choose “Apply Owner and Group to Library and All 
Enclosed Items.”

21. In the Composer toolbar, click “Build as PKG.”

22. Press Command-D to specify that the Desktop is the location to save the package to.

18

19

21

20
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23. Click Save.

24. In order to sign your package, Composer needs access your private key. At each prompt enter 
your login password and click Allow (or click Always Allow to grant Composer access to your key 
without asking for your password again).

25. Confirm that the SplashBuddy installer package is created in your Desktop.

26. Quit Composer.
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Section 9: Deploy the SplashBuddy installer package as a Computer 
PreStage Enrollment package in Jamf Pro

1. Log in to Jamf Pro. 

2. In the upper-right corner, click Settings (looks like a gear).

3. Click Packages.

4. Click New (+). 

5. Click Choose File. 

2

3
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6. Select the SplashBuddy Installer package you created using Composer, then click “Choose”

7. Set a “Category”. 

8. In the lower-right corner, click Save to complete the upload. 
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9. In the sidebar, click Computers, then click PreStage Enrollments.

10. If you do not have PreStage created, then follow this guide to create a Computer PreStage Enrollment:  
https://docs.jamf.com/10.21.0/jamf-pro/administrator-guide/Computer_PreStage_Enrollments.html

11. If you have a PreStage created previously, then select the one you wish to use. Click Clone (looks like 
two documents).
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12. In the Display Name field, replace the contents with a name. This guide uses SplashBuddy Test as 
an example. 

13. Scroll down and click “Enrollment Packages”, then click “Configure” button. 

14. Next to the SplashBuddy Installer package you uploaded in step 8 of this section, click Add.
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15. Select “Cloud Distribution Point”. Note: Don't worry if this is displayed with the text "(null)". 

16. In the lower-right corner, click Save, then click Save to confirm the change.
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Section 10: Test SplashBuddy 
SplashBuddy does not trigger policy to kickstart app installation. Which means, you need to upload 
the app installer package to Jamf then set up a policy that will install the package upon enrollment 
which this guide covers in section 6.

1. Confirm the test Mac is assigned to Jamf in Apple Business Manager.

2. Confirm the test Mac is scope to PreStage Enrollment in Jamf.

3. Turn on the Mac to begin testing.

4. Complete the Setup process to get to the Desktop.

5. If everything is done correctly, SplashBuddy will load very shortly

6. If SplashBuddy does not load upon arriving to the Desktop, then SplashBuddy Installer Package is 
created incorrectly. Verify SplashBuddy is installed by navigating to /Library/Application Support/
SplashBuddy folder in the Finder.
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7. Confirm that “io.fti.SplshBuddy.plist” is installed in the /Library/Preferences/ folder. If the file does 
not exist, then SplashBuddy Installer Package is created incorrectly.

8. Confirm that io.fti.SplashBuddy.launch.plist is installed in the /Library/LaunchAgents folder. If the file 
does not exist, then SplashBuddy Installer Package is created incorrectly.

9. Once SplashBuddy is loaded, take note of app install indicators as it turns green. 

10. If one of the app install indicators does not change to green, then the incorrect “packageName” is 
set in io.fti.SplashBuddy.plist.

11. If “canContinue” is set to false, then the button to exit SplashBuddy does not appear. Press 
Control-Option-Command-Q to quit SplashBuddy. 

12. Make sure to obtain correct “packageName” of all apps used for app install indicators described 
in section 5.

13. Another method to obtain correct “packageName” is searching the /private/var/log/install.log once 
all apps have been installed.

14. In Finder, Press Shift-Command-G, enter /private/var/log/, then click Go.

15. Double-click install.log to open the file. By default, it opens in Console.

16. After install.log is opened in Console, press Command-F.



44

How to Deploy SplashBuddy as a PreStage Enrollment Package in Jamf Pro

17. In the search field, enter Installed “GoogleChrome or Installed “Google Chrome or simply Chrome

18. Modify “packageName” in io.fti.SplashBuddy.plist to reflect the correct name(s). 

You’ve reached the end of this guide, we hope it was helpful. Feel free to continue the discussion in 
the #splashbuddy channel of the macadmins.org Slack instance, which is free for anyone who agrees 
to the code of conduct. 

If you'd like help implementing the solution in this white paper, we are ready to help; contact us at 
info@hcsonline.com or (866) 518-9672. 

If you have corrections please send them to info@hcsonline.com.

For more white papers, visit https://hcsonline.com/support/white-papers.

For more information about HCS, visit https://hcsonline.com.

You may get one of the following results:

• Installed “GoogleChrome”
• Installed “Google Chrome”
• Installed “com.google.Chrome”
• Installed “Google Chrome – 79.0.1234”
• Installed “GoogleChrome – 81.0.1234” 

<key>packageName</key>
<array>
<string>GoogleChrome</string>
<string>Google Chrome</string>
<string>com.google.Chrome</string> 

</array>

Take note the “.pkg” or version numbers such as “- 81.0.123.pkg” does not need to be 
included in the pakageName
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